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SpeedCheck 

 

With SpeedCheck, you can scan and electronically deposit your contributors’ checks into ACS. 

First, install SpeedCheck. 

Here's an overview of the SpeedCheck process: 

1. Scan your checks as batches and calculate each batch’s expected total 
2. Balance your check batch amounts 
3. Review and approve your check batches 
4. Deposit your check batches 
5. View and print SpeedCheck reports  
6. Import the transactions into ACS  

Install SpeedCheck 
Do not connect the SpeedCheck scanner to your computer until you install SpeedCheck. 

Before you install SpeedCheck: 

• Install Microsoft .NET framework version 3.5 or higher. 

• Log in as a Windows administrator on the workstation. 

Install SpeedCheck on each computer that you're connecting to a SpeedCheck scanner. 

To install SpeedCheck 

1. Before installing SpeedCheck, exit your program. 
2. Download the SpeedCheck Epson Install or the SpeedCheck SmartSource Install depending on which brand of 

scanner you purchased. 

 

3. Click Save File. 
4. Go to where you saved the file, and right-click it. Run it as an administrator. 
5. Follow the on-screen instructions, and plug in the scanner when prompted. 
6. Make sure your PC recognizes the scanner. You should see one of the following messages: "Driver 

successfully installed" or "Hardware successfully installed". If your PC doesn't recognize the scanner, 

please contact us. 

Note 

Windows 10 Users: 

Before downloading the Speedcheck Epson Install, you must have full rights to the CPI folder. 
Before downloading the Speedcheck SmartSource Install, you need full security rights to the CPI  
folder and the Silver Bullet Technology folder. 

http://www.microsoft.com/net/
http://6633ba620effd48d9401-b270dc8b5dbcc51d9af92f1736e26ec3.r99.cf1.rackcdn.com/SpeedCheckInstall_Epson.exe
http://6633ba620effd48d9401-b270dc8b5dbcc51d9af92f1736e26ec3.r99.cf1.rackcdn.com/SpeedCheckInstall_SmartSource.exe
http://portal.acstechnologies.com/acs/
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The SpeedCheck install adds an icon to your desktop. 

  

 If you need help uninstalling SpeedCheck, please contact Support at 1-800-669-2509. 

  

Scan Check Batches 
Before you scan your checks, you should separate them into groups (batches) by fund. You’ll also want 

to group together any checks with amounts that you need to split among separate funds. 

Each batch is considered a separate deposit, so you can set your own number of checks that will be in 

each of your batches. For example, if you have 300 checks and you scan 100 checks in each batch, 

you’ll have 3 deposits for that day. 

It’s a good idea to add up the check amounts for each batch in order to get an expected batch total that 

you can later compare to the scanned total. 

To scan checks 

1. Double-click the SpeedCheck icon. The Scanner window displays. 
2. Click Create New Batch. 
3. Load a batch of checks in the scanner tray. 

 
6. To scan another batch, repeat steps 3 - 5. 
7. When you’re finished scanning your check batches, click Exit. 

 

Print an Endorsement Line 
The SmartSource 55 DPM and 120 DPM check scanners let you print endorsement lines on your checks. 

To print an endorsement line, you must have rights to edit the location of the file. 

To print an endorsement line 

1. Navigate to C:\Program Files\CPI\Scanner files or C:\Program Files (x86)\CPI\Scanner files. 
2. Open the scanner.exe.config file with Notepad. 
3. On the<add key="Endorse" value="N"/> line, change N to Y. 
4. If scanning with the SmartSource 120 DPM Scanner, in the LocalEndorseText line, enter 10-15 

spaces to prevent the endorsement line from printing on the left edge.  
5. On the <add key="LocalEndorseText" value="METABANK "/> line, replace METABANK with the 

endorsement line you want to print on your checks.  

4 .   

5 .   

Click  . Start/Capture 

After the checks scan, click  . End Batch/Process 

If you're using the SmartSource scanner, you should see the SilverBullet loading screen. 

If you don't: 

Turn off the scanner 
Unplug the USB cable from your computer 
Turning the scanner back on 
Plug the USB cable back into your computer 

https://www.amazon.com/SmartSource-SSP1120100-PKA-IJ-Docs-Minute-Feeder/dp/B07BS1WV8W/ref=sr_1_4?&_encoding=UTF8&tag=acstechnologi-20&linkCode=ur2&linkId=52a33c34dd72e525e3129bcd84faca4c&camp=1789&creative=9325


 5 

Balance Check Batches 
Balancing each check batch ensures the total amount of the scanned checks matches your expected 

batch total. 

When balancing checks, you can distribute your contributions to the appropriate funds and even split your 

contributions into separate funds. All funds set up in ACS Contributions are available in SpeedCheck. 

To balance a batch of checks 

1. Under Manage Records, click the Contributions tab. 

2. Select Enter/Post Contributions from the drop-down list and click Go  . 
3. Click Import Transactions. The Import Contributions window displays. 
4. Click ACS SpeedCheck. The Select Action dialog box displays. 
5. Click Balance/Deposit Checks. The ACS SpeedCheck window displays. 

 

7. Select the Show Unbalanced Only check box at the top of the window to view only checks where their 

amount or their MICR line needs to be corrected. 

6 .   After selecting a batch from the drop-down list, the Balance window displays.  
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8. After you balance your check batches, you can review them. 

MICR Line Errors or Invalid Check Amounts 
If a red question mark displays beside a transaction, the check amount is not balanced or the MICR line 

is unclear. 

 

To see what's wrong with the check, place your cursor over the transaction, then follow the steps below 

to fix a bad MICR line. To fix a MICR line 

1. In the Balance window, double-click on a transaction with a red question mark beside it. 
2. When the image of the check displays, click on the image to verify the information in the Routing #, Ac 

count, and Check Number fields. If applicable, enter the correct information from the check. 
3. Click Save. 
4. Click Close to close the check preview and return to the Balance window. 



 7 

5. After you balance your check batches, you can review them. 
 

Review and Approve Check Batches 
You must review and approve the check batches before importing them into ACS Contributions. 

Reviewing and approving a batch ensures that you’ve distributed each check to the proper funds for the 

correct amounts and that the batch is ready for deposit. 

1. Balance each transaction in the batch. After you’ve balanced each transaction batch, the word 

Balanced displays under Batch Totals. 
2. Click Review. 
3. Compare this grid’s information with your expected total. The grid displays the batch number, 

company name, and account number, along with each transaction’s check number, envelope number 
(if applicable), contributor fund, check amount, and distribution amount. 

4. Optional: To print the grid, click Printer Friendly Version and then Print. 
5. If you find an error when reviewing the transactions, click Balance to correct a transaction’s funds 

and amounts or to split a transaction between funds. 

 

After approving the batch's totals, you cannot correct any check amount errors within the 

batch- you must delete the batch and rescan your checks. However, you can split checks 

between funds or allocate money to other funds once you import the batch into ACS 

Contributions. 

1. Click on the Approve tab. 
2. Compare this grid’s information with your expected total. If you want to print the grid, click Printer 

Friendly Version and then Print. 
3. If you find an error when reviewing the transactions, click Balance to correct a transaction’s funds 

and amounts or to split a transaction between funds. 
4. When all transactions match the expected totals, click the Approve button to approve the 

transactions. 
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Deposit Check Batches 
 

For SpeedCheck Clients 

To use the remote deposit feature, you must purchase the option for SpeedCheck. To learn about 

pricing or to purchase this option, contact your sales representative or call 1.800.736.7425. 

If you use the Remote Deposit feature, you can electronically deposit your batches of checks after 
reviewing and approving them.  

If you're not using the Remote Deposit feature, you still must select Deposit so that the correct files are 
created to import the checks into ACS Contributions.  

Your bank account information is on file, so you won't need to enter it each time you deposit. After 
depositing checks, 100% of your funds will be available in two business days. 

To Deposit Checks 

1. Click on the Deposit tab. 
2. Compare the information in the grid to the expected total. You can also click Printer Friendly Version 

to display and print the grid for your records. 
3. Click the Deposit button. When you click Deposit, the batch is submitted for deposit at the end of the day. 
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After you deposit the checks, you're ready to match the checks to transaction records in ACS. 

 

SpeedCheck Reports 
SpeedCheck has five reports that you can view, print, or save for your internal records. 

 Check Only Reports — Displays the Check Number and Check Amount for each check in a batch.  
Before processing the report, you must select a batch in the Select Batch or Batch Date drop-down list.  
You can use this to compare your expected total list to SpeedCheck and find discrepancies. Daily 

Reports — Displays the Batch Name and Deposit Amount for each batch deposited on the 

current day. You can only access this report the day the batch was deposited. 
Batch/Check Report — Displays all check batches within a selected date range. You can also view the 
batch's date, name, ID, and check count. Click on a batch to view each transaction's ID, bank number, 

account number, check number, and check amount. 

 Deposits Query — View deposits made today, yesterday, this week, or this month. 
Check Search — Search for a check based on the bank number, account number, check number, 

amount, or scan date. 

To view and print reports 

1. Click on the Reports tab. 
2. Click the report that you want to view or print. 
3. When the report displays, click Printer Friendly Version, then click Print to print the report. 
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View Batch Details and Delete Batches 
You can view the details of a batch of checks. When you view a batch’s details, you can click Delete to 

remove it, unless it has been deposited. 

 

The Batch Details display: 

Who scanned the batch. 
When they scanned it. 
The batch ID number. 
Miscellaneous information about the batch. 

To view batch details or delete a batch 

1. In the Enter/Post Transactions window, click Import Transactions, then Speed Check. 
2. In the Select Action window, click Balance/Deposit Checks. 
3. In the Select Batch or Batch Date drop-down list, select the batch that you want to view. 
4. Once you’ve selected the batch, click System and select Batch Details. 
5. The batch details display. If you want to delete the batch, click Delete. Otherwise, click any of the other 

tabs in the Speed Check window or click Close to exit. 

Be Careful 

Deleting a batch requires you to recapture the checks and review and approve them again. 
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After you close this window, the Import window will display. 

Import SpeedCheck Transactions into ACS Contributions 
When you’re ready to import transactions, click Import (the Import button will not be available until all 
transactions have been matched). 
 

• Once you import transactions into Contributions, you will work with them just as you work with your 

other transactions by posting them to Contributions and General Ledger (if interfaced) and printing the 

weekly register and General Ledger distributions. 

• In addition, it's a good idea to include the Batch ID from the Import window in the G/L posting 

description, in case you need to refer back to the checks. 

Match and Reassign Transaction Records 
When you finish working in Balance/Deposit Checks and close the window, ACS automatically checks for new 

batches of deposited checks. 
Your next step is to import the batches of checks you deposited into ACS so that you can match them to your 

contributors’ records and post the contributions. 

1. Under Manage Records, click the Contributions tab. 

2. Select Enter/Post Contributions from the drop-down list and click Go  . 
3. Click Import Transactions. The Import Contributions window displays. 
4. Click ACS SpeedCheck. The ACS SpeedCheck window displays. 
5. In the Select Batch drop-down list, choose a batch to match transactions to. In this window, you'll 

see two grids: 
a. Unmatched Records 
b. Matched Records 



 12 

6. In the Select Open Batch drop-down list, make a selection. 
7. Scan for unmatched transactions, and manually match them. As they are matched, they move to the 

Matched Records grid. 
8. Once you’ve matched all transactions to individual or organization records, click Import. Your 

transactions are now in Contributions. 

1. Under Manage Records, click the Contributions tab. 

2. Select Enter/Post Contributions from the drop-down list and click Go  . 
3. Click Import Transactions. The Import Contributions window displays. 
4. Click ACS SpeedCheck. The ACS SpeedCheck window displays. 
5. In the Select Open Batch drop-down list, make a selection. 
6. Under Unmatched Records, click a record to view the check image. 
7. Click Match Record to Individual if the check is from an individual. 
8. Locate the individual you want to match transactions to and click OK. If the contributor does not have 

a record in ACS, click Add New Family or Add Family Member to add a record for the contributor in 

ACS. 
9. Enter the contributor’s information in Add New Family and click Save, then OK. 

1. Under Manage Records, click the Contributions tab. 

2. Select Enter/Post Contributions from the drop-down list and click Go  . 
3. Click Import Transactions. The Import Contributions window displays. 
4. Click ACS SpeedCheck. The ACS SpeedCheck window displays. 
5. In the Select Batch drop-down list, select the batch of transactions you want to match to individuals 

and organizations. 
6. In the Select Open Batch drop-down list, make a selection. 
7. Under Unmatched Records, click on a record to view the check image. 
8. Click Match Record to Organization if the check is from an organization. 
9. Locate the organization you want to match the record to and click OK. If the organization does not 

have a record in ACS, click Add New Organization to add a record for the organization in ACS. 
10. Enter the organization’s information in Add New Organization and click Save, then OK. 

 

How Records Are Matched 

ACS automatically matches records based on an individual or organization’s bank account and 

routing numbers. If an individual or organization in ACS does not have a bank account and routing 

number associated with his or her record, you can easily match the record in the Import window, 

and all future check contributions scanned are matched to that record. 

Correcting Mismatched Records 
You can reassign and unmatch records if you need to. 

Why reassign a record? 

If you reassign a record, you can save the transaction to another ACS record. Suppose you accidentally 

match a check to the incorrect individual or organization record.  You can quickly correct this by 
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reassigning the record. Now, when a transaction is reassigned to a new individual or organization, all 

future transactions will be assigned to that individual or organization as well. If a check is automatically 

matched to a contributor, you can reassign these contributions in CB Setup - Checking Account 

Maintenance.  
Records that are linked to bank accounts cannot be reassigned. 

Why unmatch a record? 

Unmatching the record means that you have completely disassociated the transaction with the current 

matched record or any other record. For example, you manually matched a record to Robert Howell. The 

following week, you overhear a conversation and realize that you matched this to a member record 

(Robert L. Howell), but the contributor is actually Robert S. Howell, a visitor with no record in ACS. 

When records are unmatched, the transaction displays under Unmatched Records, and you can either 

match the record to an individual or organization or add a new record for the new contributor. Once the 

record is matched to a new individual or organization, all future transactions from that contributor will also 

be matched to him or her. 

1. Under Manage Records, click the Contributions tab. 

2. Select Enter/Post Contributions from the drop-down list and click Go  . 
3. Click Import Transactions. The Import Contributions window displays. 
4. Click ACS SpeedCheck. The ACS SpeedCheck window displays. 
5. In the Select Batch drop-down list, select the appropriate batch of transactions. 
6. In the Select Open Batch drop-down list, make a selection. 
7. Under Matched Records, find and select the transaction record you want to reassign. 
8. Click Reassign Record to Individual or Reassign Record to Organization. 
9. In the Find Person or Find Organization window, find and select the individual or organization 

record you want to reassign the transaction record to. 
10. If the contributor does not have a record in ACS, click Add New Family or Add New Organization 

t o add a record. 
11. Click OK. 

1. Under Manage Records, click the Contributions tab. 

2. Select Enter/Post Contributions from the drop-down list and click Go  . 
3. Click Import Transactions. The Import Contributions window displays. 
4. Click ACS SpeedCheck. The ACS SpeedCheck window displays. 
5. In the Select Batch drop-down list, select the appropriate batch of transactions. 
6. In the Select Open Batch drop-down list, make a selection. 
7. Under Matched Records, select the transaction record you want to unmatch. 
8. Click Unmatch Record. The transaction record will display under Unmatched Records. 
9. To match the record to another individual or organization, click Match Record to Individual or 

Matc h Record to Organization. 
10. In the Find Person or Find Organization window, find and select the individual or organization 

record you want to reassign the transaction record to. 
11. If the contributor does not have a record in ACS, click Add New Family or Add New Organization 

t o add a record. 
12. Enter the contributor’s information and click Save. 
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View Check Images 
After the contributions batch has been posted, you can view the check image for each transaction using 

the Inquiry by Individual option in Contributions. 

The check's image becomes a legal document, and if the physical check was destroyed after depositing, 

you can access and refer to the scanned images as needed. 

Check images are available for 24 months after the deposit date, and you can view scanned checks in 

ACS Contributions or in SpeedCheck. 

1. Open ACS SpeedCheck. 
2. Select Balance/Deposit. 
3. In the Select Batch drop-down list, select the batch of checks you want to access. Then, you can 

click the magnifying glass to view the check image. 

You can view check images in the Batch/Check Report inside SpeedCheck. 

1. Open ACS SpeedCheck. 
2. Select Balance/Deposit. 
3. Select Reports > Batch/Check Report. 
4. Enter a date range, and select Search. 
5. Deposits for the selected date range will display. 
6. Click on a deposit, and click the magnifying glass to view the check image.  

13 .   Click   to return to Remote Deposit Capture. OK 

Useful Information 

Bill Pay Account checks are checks that come from banks on behalf of the contributor. You can  
have multiple Bill Pay account checks with the same routing # and checking account #. You don't  
want these checks to be associated with an individual, as this will cause you to post these checks  
to incorrect individual contribution records. 

You can convert a check to a new Bill Pay account in the Speedcheck window for importing  
batches: 

For unmatched records, click  . Make Bill Pay Account 
For matched records, click  . Unmatch Record And Make Bill Pay Account 
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SpeedCheck - Frequently Asked Questions 
 

Banking 

 

Will SpeedCheck's remote deposit option work with my bank? 

Because all banks can receive electronic funds, SpeedCheck works with any U.S. bank. Many banks 

encourage electronic checks because it saves them the cost of handling paper checks, results in faster 

access to funds, and allows easy transaction processing. However, you will need to contact your bank to 

ensure that they will accept your electronic deposits, which are submitted as ACH credits. 

When are my transactions deposited? 

Transactions are not automatically deposited when you click Deposit. Scanned transactions deposited 

by 4:30 PM CST are processed the same day. The transaction fee you are charged depends on the total 

number of checks deposited, not the number of batches scanned. 

How long will it take for me to see the money in my account? 

Usually, the deposit will be credited in your account and 100% of funds will be available within 2 business 

days. How this compares with your current situation may vary. Often with paper deposits, funds are 

credited in your account but are not yet available for use. With SpeedCheck, funds are available for use 

once the deposit shows up in your account. 

What happens if a check is returned due to Non-Sufficient Funds? 

If a check is returned due to Non-Sufficient Funds (NSF), a member of the ACS Support Team will 

contact you with the check information. You will need to manually update this information in ACS 

Contributions as part of your internal processes, since the returned check was processed as a part of the 

batch. Returned checks are submitted to your bank as ACH debits. 

Checks less than $100 are automatically resubmitted one time. Checks of $100 or more are returned 

without being resubmitted, but can be resubmitted per your request. The resubmit option is set between 

our processing bank and the Federal Reserve and cannot be disabled. 

If you find that funds are available for the check and need to resubmit it, contact the ACS Support Team 

with the check information. Do not scan and redeposit the check.  

Returned checks are submitted to your bank as ACH Debits. A $7.00 fee is charged for each check 

returned due to non-sufficient funds, and returned item fees are listed separately on your ACS monthly 

billing statement. Your bank should not charge separate return check fees. 

Scanning 

 

What is the check scanner and what does it do? 

The SpeedCheck Scanners are used to scan batches of checks, which you can also remotely deposit, 

with ACS SpeedCheck. This scanner reads the check’s amount and number, bank account number, and 

the bank’s routing number. When you scan a check, an electronic image of both the front and back of the 
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check is created. Under the Check Clearing for the 21st Century Act (Check 21 Act), this digital image 

maintains the status of a legal check and can be deposited electronically. 

ACS offers three scanners, all of which are remote deposit ready. The Speed Check Scanner single feed 

scans one check at a time. The SpeedCheck Scanner 30 DPM and SpeedCheck Scanner 55 DPM scan 

30 or 50 documents per minute, respectively.  

Where can I purchase the scanner? 

You must purchase the scanner directly from ACS Technologies, and your one-time setup fee is included 

in the scanner's cost. You can purchase the scanner by contacting your Sales representative or calling 

1800-736-7425. 

How many checks can I scan at a time? 

The SpeedCheck Scanner single fee scans one check at a time. The Speed Check Scanner 30 DPM and 

Speed Check Scanner 55 DPM scan 30 or 55 documents per minute, respectively. Checks scan one at a 

time, but we suggest dividing checks into batches. While you can scan larger batches, SpeedCheck is 

most efficient when 55 or fewer checks are scanned in a batch. The scanner automatically pulls the 

checks through, so you’ll simply place your batch of checks in the scanner, click Capture Checks, and 

the scanner will do the rest. 

What kind of checks can I scan? 

You can scan and deposit personal checks, money orders, and bill pay account checks. You can even 

scan and deposit over the counter checks, provided the MICR information for that check is entered 

correctly. You can also scan checks of different heights and widths without any problems, but to get the 

best image quality, be sure to align all checks evenly at the bottom. 

What if a contributor is a first-time visitor and does not have a record in ACS? 

If a contributor does not have a record in ACS, you can easily add a record after scanning checks. 

Contributors and checks are matched by bank account number and bank routing number, so once a 

contributor is matched, you will not have to match them the next time you scan checks if their check has 

the same bank routing and account numbers. 

How long should I keep the checks after scanning them? 

You should keep hard copies of all scanned and deposited checks for at least 14 days. Within 3 days of 

scanning a batch, you will be notified of any returned checks. All check images are stored on a secure 

server for 24 months from the date of the deposit. 

Integration with ACS 

 

Does SpeedCheck work with OnDemand? 

Yes. 

Does SpeedCheck work with Macs? 
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If you use a Mac, you can deposit, split checks, and allocate checks to funds in ACS Contributions 

through OnDemand, our hosted software solution. However, the check scanner must be connected to a 

PC workstation to scan the checks. 

I’m an organization client.  Can I use SpeedCheck? 

Yes. You can match checks to organizations’ records just as you can match them to individual records. 

What are the system requirements for SpeedCheck? 

SpeedCheck’s system requirements are the same as ACS system requirements; however, you must 

have ACS 10.3 or higher and a high-speed Internet connection. To download the latest version of ACS, 

visit the d ownload site . If you are an ACS OnDemand client, a representative will contact you to install 

the latest version of ACS. 

You must also own ACS Contributions, have an active support contract with auto-draft enrollment, and 

install 3.5 and older .NET framework. 

Does SpeedCheck work with split transactions? 

Yes. For example, suppose an individual gives a check for $100, with $75 designated for the general 

operating fund and $25 designated for missions. If you scan a batch of checks where each check has 

money allocated to the general operating fund, you could select that as the default fund and then 

manually split the rest of the amount between funds. 

Does SpeedCheck work with bill pay accounts? 

Yes, you can scan and deposit checks from bill pay accounts like any other check; however, you will 

need to set up a record for the bill pay account before scanning checks. You can do this on the Checking 

Account Maintenance tab in Contributions Setup. 

Can I use SpeedCheck at any time? 

Yes- you can even scan and deposit checks when the bank is closed, such as on Sunday afternoons. 

However, deposits are only processed on normal banking days. 

In addition, SpeedCheck is a Web application, so a reliable Internet connection is needed. In addition, our 

Web applications occasionally undergo scheduled system upgrades to increase capacity, improve 

features, and provide you with the best experience possible. 

In the event of scheduled maintenance, you will be notified at least one week in advance. However, if a 

critical update is needed, we reserve the right to load updates at any time to best serve you and your 

ministry’s needs. 

Billing 

 

How do I pay? 

ACS requires upfront payment for the scanner and setup fees, and all deposit, transaction, and monthly 

support fees must be paid by ACH bank draft. For example, February’s invoice includes fees from 

January’ s transactions and March’s monthly account maintenance and support fee. 

What does it cost? 

http://apps.acstechnologies.com/support/downloads/acs10x/
http://apps.acstechnologies.com/support/downloads/acs10x/
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To learn about pricing, contact our Sales department at 1-800-736-7425. 

SpeedCheck Scanners 
ACS offers three SpeedCheck scanners to fit your needs. All scanners are remote deposit ready.  

SpeedCheck Scanner Single-Scan 

 

SpeedCheck Scanner 30 DPM 

 

SpeedCheck Scanner 55 DPM 

 

The SpeedCheck Scanner- Single-Scan scans and loads checks one at a time. 

The SpeedCheck Scanner - 30 DPM scans multiple checks with speeds up to 30 documents per minute. 

The SpeedCheck Scanner - 55 DPM scans multiple checks with speeds up to 55 documents per minute. 
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SpeedCheck Scanner 120 DPM 

 
 

Using the Bluetooth Scanner with Remote Desktop 

Connection 
The BlueTooth scanner works with Remote Desktop Connection 6.0 on Windows 7 and higher. Make 

sure that that the scanner works locally first, then complete the following steps to make it work in 

Terminal Server: 

1. On the Windows taskbar, click Start > All Programs > Accessories > Remote Desktop 

Connection. 
2. Click Options. 
3. Click on the Local Resources tab. 
4. In the Keyboard drop-down list, select On this computer. 
5. Under Local devices and resources, click More. 
6. Select Serial Ports and Other supported Plug and Play (PnP) devices, then click OK. 
7. Click Connect, log into Terminal Server, then click Yes to connect your computer. 
8. Follow the instructions for setting up the scanner for Contributions and Accounts Receivable. 

 

1. On the Windows desktop, click the Start button  in the lower-left corner of the screen. The 

Start screen displays. 

2. Click the arrow button . The Apps view displays. 
3. Click Remote Desktop Connection. 
4. Click Show Options. 
5. Click on the Local Resources tab. 
6. In the Keyboard drop-down list, select On this computer. 
7. Under Local devices and resources, click More. 
8. Select Ports and Other supported Plug and Play (PnP) devices, then click OK. 
9. Click Connect, log into Terminal Server, then click Yes to connect your computer. 
10. Follow the instructions for setting up the scanner for Contributions and Accounts Receivable. 

The    scans multiple checks with speeds up to 120 documents per minute. SpeedCheck Scanner - 120 DP M 

https://www.amazon.com/SmartSource-SSP1120100-PKA-IJ-Docs-Minute-Feeder/dp/B07BS1WV8W/ref=sr_1_4?&_encoding=UTF8&tag=acstechnologi-20&linkCode=ur2&linkId=52a33c34dd72e525e3129bcd84faca4c&camp=1789&creative=9325
https://www.amazon.com/SmartSource-SSP1120100-PKA-IJ-Docs-Minute-Feeder/dp/B07BS1WV8W/ref=sr_1_4?&_encoding=UTF8&tag=acstechnologi-20&linkCode=ur2&linkId=52a33c34dd72e525e3129bcd84faca4c&camp=1789&creative=9325
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Using the Fusion Omnidirectional Scanner 
The Fusion® is a lightweight and ergonomic hand-held scanner capable of omnidirectional and single-line 

barcode scanning. It’s ideal for churches with busy check-in stations and schools or child care facilities 

that mark attendance. Plus, there are no software drivers to load – just plug and play! You can use it to 

scan barcodes in any orientation. For information about purchasing the Fusion Omnidirection Scanner, 

visit our o nline store. 

 
  

1. Plug the cord into the USB port of your computer. 
2. Once your computer finds the scanner, it is ready for use. 

Useful Information 

If your scanner isn't scanning, distance from the scanner to the barcodes may be an issue.  
Move the scanner closer and farther away until you find the correct range. 
ACS Technologies recommends, when you're scanning multiple barcodes at once, you hold the 

trigger and scan all, rather than pressing the trigger and scanning repeatedly for each barcode. 

  

Scanning and Posting Checks in Contributions 
1. When you add or edit a transaction, Scan Check is available. To scan a check, click Scan Check. 
2. Insert the leading edge of the check into the scanner. Make sure the MICR line is down and the 

printed side faces the center of the MICRImage. 
3. Slide the check forward until the MICRImage motor turns on. Release the check when the scanner 

grabs it, and the check will be transported around the check path. 
4. Remove the check. 

After the MICRImage reads the check, the information will be transmitted by specific parameters. 

After the information from the check is transmitted, the Find Person window displays. Select the 

contributor from the list or click Add New Family. If the family has a record on the Checking Account 

Maintenance tab in Contributions Setup, the record displays and you can enter the transaction type, 

Push button targeted single-line scanning option 

Hands-free operation, reducing operator fatigue 

Multiple sleep modes with IR (infra-red) wake up 

Mountable stand with three locking positions 

User configurable depth of field 

Easy barcode configuration 

https://store.acstechnologies.com/
https://store.acstechnologies.com/
https://wiki.acstechnologies.com/display/ACSDOC/Adding+a+New+Transaction
https://wiki.acstechnologies.com/display/ACSDOC/Adding+a+New+Transaction
https://wiki.acstechnologies.com/display/ACSDOC/Checking+Account+Maintenance
https://wiki.acstechnologies.com/display/ACSDOC/Checking+Account+Maintenance
https://wiki.acstechnologies.com/display/ACSDOC/Checking+Account+Maintenance
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amount, and fund. If the family is not already entered on the Checking Account Maintenance tab, 

ACS automatically adds one. 

After you scan the checks, you must post your transactions to Contributions and General Ledger (if 

interfaced) and print any reports you need. 

To view an image of the scanned check, click Inquiry by Individual. On the Gifts tab, scroll to the right 

until the Image column is visible. Double-click Dbl Click for Image to display an image of the scanned 

check. 

 

Scanning and Posting Checks in Accounts Receivable 
1. When you add or edit a payment, Scan Check is available. To scan a check, click Scan Check. 

 

The Add Payment window 
2. Insert the leading edge of the check into the scanner. Make sure the MICR line is down and the printed side 

faces the center of the MICRImage. 
3. Slide the check forward until the MICRImage motor turns on. Release the check when the scanner grabs it, 

and the check will be transported around the check path. 
4. Remove the check. 

After the MICRImage reads the check, the information will be transmitted by specific parameters. 

After the information from the check is transmitted, the Add/Edit Customers window displays. Select 

the customer from the list or click Add to add a new customer. If the customer has a record on the 

Contributions - Inquiry by Individual 

Tip 

If the image column does not display, right-click within the   tab window, click  , then  Gifts Customize 
select   and  . Image (Prompt) Image (Icon) 

https://wiki.acstechnologies.com/display/ACSDOC/Posting+a+Deposit
https://wiki.acstechnologies.com/display/ACSDOC/Contributions+Reports+and+Statements
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Bank Account Maintenance tab in Accounts Receivable Setup, the record displays and you can enter 

the remaining fields in the Add Payment window. If the customer is not already entered on the Bank 

Account Maintenance tab, ACS automatically adds one. 

After you scan the checks, you must post your payments in Accounts Receivable. 

  

ID Card Printers 
The Zenius and Primacy ID card printers work with ACS Attendance and Checkpoint in both ACS 

Desktop and OnDemand. 

Three models are available for purchase. To learn more, select a topic below: 

 Using the Zenius and Primacy ID Card Printers 
Installing the eMedia - Cards CS Software for Zenius and Primacy ID Card Printers 

The Tattoo 2, Pebble 4, and Dualys 3 ID card printers work with ACS Attendance and Checkpoint in both 

ACS Desktop and OnDemand. They are still supported, but are no longer available for purchase. 

Using the Zenius and Primacy ID Card Printers 
 

Operating System Requirements 
To use the below ID card printers, you must run one of the following operating systems: Windows 7, 

Windows 8.1, or Windows 10. 

Models available for purchase: 

Zenius Single Sided 
Primacy Single Sided 
Primacy Dual Sided 

The printers work with ACS Attendance and Checkpoint in both ACS Desktop and OnDemand. You can 

also use these card printers with HeadMaster, and can print directly from one of the HeadMaster Reports. 

Some organizations have integrated ID cards to use with their check-in system. You can design these 

cards with barcodes to scan and check people in using the eMedia - Cards CS software that comes with 

the printer. 

1. Insert the CD that came with your printer. When the language prompt displays, select English. 
2. Select the printer you are installing (Zenius or Primacy). 
3. Select to Install the driver, and click OK for English. 
4. Click Next to install the Evolis Premium Suite. 
5. Accept the warranty terms of agreement, then click Next for the following four prompts. 
6. In the Setup window, select all checkboxes to install the desktop icons. Click Next, then click Install. 
7. When the software installation warning displays, click Continue Anyway. 
8. Click Next on the following two prompts, then click Finish. 

 

https://wiki.acstechnologies.com/display/ACSDOC/Configuring+the+Bank+Account+Maintenance+Tab
https://wiki.acstechnologies.com/display/ACSDOC/Configuring+the+Bank+Account+Maintenance+Tab
https://wiki.acstechnologies.com/display/ACSDOC/Posting+Payments+in+Accounts+Receivable
https://wiki.acstechnologies.com/display/ACSDOC/Attendance
https://wiki.acstechnologies.com/display/ACSDOC/Checkpoint
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Installing the eMedia - Cards CS Software for Zenius and Primacy 

ID Card Printers 
When you purchase the Zenius or one of the Primacy ID card printers, you also receive the eMedia - 

Cards CS software. 

 

You can insert images, backgrounds, and barcodes on your cards, and you can import the names of your 

members from ACS People. 

To create the file with the members' names, you can use the Advanced Export option. You can create an 

advanced export using many different criteria, including member status, family position, age, and 

attendance class. For example, you can create an advanced export for all children enrolled in Sunday 

School classes. 

1. Insert the CD that came with your printer. 
2. Select Install eMedia CS trial. 
3. Click OK for English, then click Next. 
4. Accept the terms of agreement, then click Next for the following two prompts. 
5. To place icons on the desktop, select all check boxes and click Next. 
6. Click Install, then click Finish. 

 

Creating ID Cards with the eMedia - Cards CS software 
There are two methods you can use to create ID cards with the eMedia - Cards CS software. Before 

using the following procedures, make sure that you have installed the eMedia - Cards CS software. 

  

1. On your Windows desktop, double-click the eMedia icon. The eMedia window displays. 
2. On the toolbar, click View > Design Mode. 
3. On the toolbar, click Card to select the type of card you want to print. A context menu drops down 

from which you can make selections about the card. After you make your selections, the Front side 

window displays for you to add information to the front side of the card. 

4. To add text for the card, in the Toolbox, click . Enter your text in the Data in this object field on 

the right pane. You can change the font by using the toolbar at the top of the right pane. 

https://wiki.acstechnologies.com/display/ACSDOC/Advanced+Exports
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5. To add a barcode for the card, in the Toolbox, click . Enter the numbers for the barcode in the D 

ata in this object field on the right pane. 
6. To view the card before saving and printing, on the toolbar, click View > Operating Mode. 
7. To save the card, on the toolbar, click File > Save. 

 

1. On your Windows desktop, double-click the eMedia icon. The eMedia window displays. 
2. On the toolbar, click Tools > Connect to database. The Database connection window displays. 
3. Select your version of Excel, and click Next. 
4. Browse to the Excel file, and click Next. 
5. No information is required in this window. Click Next. 
6. Select the records set that you want to use, and click Next. 
7. Select Add records, and click Next. 

8. You can sort by last name by clicking  in the Sort column of the grid. Click Next. 
9. To save your information, click Finish. The Front side window displays for you to add information to 

the front side of the card. 
10. To add a first name to the card, click in the text field located within the Front side window. 
11. In the right pane, select Database Field from the Source drop-down menu. 
12. In the right pane, select FirstName from the Field drop-down menu. 
13. Repeat steps 10 through 12 to add a last name. 

14. To add a barcode for the card, in the Toolbox, click .  
15. In the right pane, select Database Field from the Source drop-down menu. 
16. In the right pane, leave the Field entry blank. 
17. In the right pane, enter "3 of 9" in the Type field. This is Code 39, for ACS software. 
18. To print, click View > Operating Mode. The software prints one card at a time. Use the right arrow  

 to select the next name each time. 

 

 

Printing ID Cards using HeadMaster Reports 
You can print ID cards for HeadMaster using the Zenius and Primacy ID Card printers. Instead of using 

the eMedia software, you can print directly from the Student ID Cards report. You will need to contact 

Support at 1-800-669-2509 to get a file to use with this report. 
 

1. On the Home screen, or on the Main Shortcuts menu, click Reports. 
2. Under Report List, expand List. 
3. Select Student ID Cards (Avery 5371). 
4. Right-click on the report, and click Copy. 
5. Right-click on the copy of the report, and click Edit. 
6. Click File, Open. Open the file given to you by Support. 

7. Click Label  , then click anywhere on the badge to insert the label. 
8. Delete the label. (This is to make a change in the report so that it can be saved.) 

9. Click Close . When the confirmation message displays to save changes, click Yes. 

https://wiki.acstechnologies.com/display/headmaster/HeadMaster
https://wiki.acstechnologies.com/display/headmaster/Print+ID+Cards+Using+HeadMaster+Reports
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10. Optional: To use a previously saved search, click the Use Search list. Searches will be limited to 

the appropriate type. 
11. Optional: To sort data on the report, click the Sort by list. Sort by arranges data in ascending or 

descending order for the field selected. Next, select either the Ascending or Descending option. 
12. Optional: To group data on the report, click the Group by list. 
13. Optional: Set filters as desired. 
14. To preview the report, click Print Preview. To print, click Print. 

  

Using the Tattoo 2, Pebble 4, and Dualys 3 ID Card Printers 
The below ID card printers work with ACS Attendance and Checkpoint in both ACS Desktop and 

OnDemand. These models are still supported but are no longer available for purchase. 

Tattoo 2  
Pebble 4  
Dualys 3 

Some organizations have integrated ID cards to use with their check-in system. You can design these 

cards to have barcodes that you can scan to check people in using the eMedia Card Designer software 

that comes with the printer. 

 

Using the Code Reader 2300 Bluetooth Scanner 
The Code Reader™ 2300 Bluetooth scanner works with ACS Checkpoint in ACS Desktop and ACS 

OnDemand. 

The Code Reader is a lightweight and ergonomic hand-held scanner capable of omnidirectional and 

singleline barcode scanning. It’s ideal for churches and child-care facilities with busy check-in stations for 

attendance. You can use it to scan barcodes in any orientation. There are no software drivers to load – 

just plug and play! 

 
  

For more information about purchasing the Code Reader 2300 Bluetooth scanner, visit our online store. 

   

High speed, omnidirectional reading of 1D, 2D, and postal barcodes 

Unequaled performance on rounded, curved, and shiny surfaces 

Multiple programmable buttons for customized workflow processes 

Reads bar codes on cell phone screens 

Durable, quick-release rechargeable battery cartridges 

  

https://wiki.acstechnologies.com/display/ACSDOC/Checkpoint
https://store.acstechnologies.com/
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Using the Zebra GX420d Wireless Thermal Label Printer 
The Zebra GX420d works with ACS Checkpoint in both ACS Desktop and OnDemand. 

This printer offers a small footprint, and it’s designed for low- to mid-volume label printing needs. The 

GX420d is ideal for uses such as person ID & access control, security, and photo processing labels. 

 
  

For more information about purchasing the Zebra GX420d thermal desktop label printer, visit our online 

store. 

  

eMedia Card Designer 
When you purchase one of the ID card printers, you will also receive the eMedia Card Designer software.  
You can insert images and barcodes on your cards, and you can import the names of your members from 

ACS People. To create the file with the members' names, you can use the Advanced Export option. You 

can create an advanced export using many different criteria, including member status, family position, 

age, and attendance class. For example, you can create an advanced export for all children enrolled in 

Sunday School classes. 

  
Sample ID Card 

 

Direct thermal printing 

200- dpi print quality 

Adjustable sensor option 

One-touch button for immediate media registration 

Compatible with multiple media sizes 

https://wiki.acstechnologies.com/display/ACSDOC/Checkpoint
https://store.acstechnologies.com/
https://store.acstechnologies.com/
https://store.acstechnologies.com/
https://wiki.acstechnologies.com/display/ACSDOC/Advanced+Exports

